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Guide for Conducting a Survey/Audit/Appraisal  
 
XPRIMER SERVER CONNECTIVITY 
 
You must have internet access enabled on your computer in order to conduct surveys, audits, and appraisals 
using XPRIMER. The status of the connection is indicated on the lower right hand corner of the XPRIMER 
application windows.  Status is shown as GREEN (ON) or RED (OFF). 
 
PRODUCT VIDEO 
 
Please review our S:PRIMERPlus product video on WWW.GRAFP.COM before proceeding, as this will 
provide a helpful overview of XPRIMER’s functionality. S:PRIMERPlus is a specific application of 
XPRIMER in the field of software engineering. 
 
TERMINOLOGY 
 
The use of the term ‘Assessment’ in this Guide implies a Survey, Audit or Appraisal (which ever is applicable 
to your circumstance and use of XPRIMER). 
 
The use of the term ‘Lead Assessor’ in this Quick Reference Guide implies a Survey Coordinator, Lead 
Auditor, Lead Assessor, or Lead Appraiser (which ever is applicable to your circumstance). 
 
The use of the term ‘Assessor’ in this Guide implies Audit Team Member, Assessment Team Member, or 
Appraisal Team Member (which ever is applicable to your circumstance). 
 
SCENARIOS SUPPORTED BY XPRIMER 

XPRIMER supports several scenarios listed in an increasing level of accuracy:  

• A survey will be conducted and there will be no verification of survey results. This is the 
SURVEY mode.  [In this mode, there is still some flexibility provided to permit modifications to 
questionnaire responses where the Lead Assessor feels a question may have been misunderstood 
or misinterpreted, and where  evidence to substantiate his/her claim has been captured.  This mode 
also permits the examination of ‘what if’ scenarios] 

• There will be no survey but a team of Assessors will collect evidence and provide corroboration 
for each question of the survey, even though they do not complete the survey as such (i.e. they 
only suggest responses to the Lead Assessor, who has the last word).  This is the 
VERIFICATION mode. [Note: XPRIMER functionality is compliant with international audit and 
appraisal standards (e.g. SCAMPI, ISO).] 

• A survey will be conducted with Respondents and a verification of survey results will be carried 
out with Assessors, who will corroborate or challenge Respondents' responses.  This is the 
SURVEY AND VERIFICATION mode. 

 
The second and third bullets require some explanation. The essential difference between a Respondent and an 
Assessor is that a Respondent, as the name implies, provides responses to a survey whereas an Assessor 
suggests responses based on collected evidence. In the latter, it is the Lead Assessor who provides the final 
responses. A Respondent typically responds to the survey and provides comments (in that sense, a 
Respondent is usually biased because he or she responds on the basis of his or her perception). In the second 
bullet, an Assessor suggests responses to the Lead Assessor, which must reflect the corroborated evidence 
that the Assessor has collected and as such, the Assessor is more likely to be unbiased. Whereas comments 
are optional for a Respondent, they are mandatory for an Assessor who provides them in the form of 
observations. In the third bullet, the Assessor only suggests a response, as is the case in the second bullet, but 
he or she has access to the information provided by the Respondents; the Assessor's task consists of verifying 
the information provided by Respondents and to either confirm or refute them with his or her own 
observations.  
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CREATING A SURVEY/AUDIT/APPRAISAL FILE. 
 
If you wish to create a new assessment, one way to accomplish this is to select New assessment from the 
pop-up bar when the File menu pad is selected. You will then be prompted to enter the: 
 

• Assessment Name:  Type in the name of you survey/audit/appraisal. 
• Type of assessment: Select ‘Biased’ if you are in the SURVEY mode or SURVEY AND 

VERIFICATION mode. Otherwise, select ‘Unbiased’. 
• Available Models:  Select a model from the list of available models. If you select a model that has 

been designated as ‘Private’ by its author, you will be prompted for a password. If you have not 
been provided with the password for a ‘Private’ model, you will not have access to the model.  
Selecting a ‘Public’ model will not prompt you for any password. 

• Lead Assessor Alias:  Type in an ‘alias’ for confidentiality purposes (e.g. lead, coordinator, 
alpha).  Alias names will also be assigned to all participants of the assessment. 

• Lead Assessor Email Address: Type in your email (if you will be the Lead Assessor for this 
exercise, be it a survey, audit or appraisal. 

 
SAVING A SURVEY/AUDIT/APPRAISAL FILE. 
 
It is a good practice to save an assessment file as soon as it has been created and to periodically save the 
contents of your assessment file as various activities are conducted. One way to save your assessment file is 
by selecting Save or Save as from the pop-up bar that appears when the File menu pad is selected.  You will 
then be prompted to enter the file name you wish to have this assessment saved under and to select a folder in 
which to save this file.   
 
IT IS RECOMMENDED TO SAVE ALL ASSESSMENTS UNDER THE ‘ASSESSMENTS’ FOLDER 
WITHIN THE DIRECTORY IN WHICH THE XPRIMER APPLICATION WAS INSTALLED. 

CONDUCTING ‘WHAT IF’ SCENARIOS 

The XPRIMER application supports “what if” scenarios by allowing the Lead Assessor to modify question 
responses provided by participants and then regenerating results.  This will allow the Lead Assessor to see 
hypothetical results of a subsequent assessment if conditions were to improve (or deteriorate) by modifying 
question responses accordingly. 

The course of action normally involves the Lead Assessor making a backup of the initial assessment first, as 
this is good practice (through the FILE –Save as command), before making modifications to the question 
responses.  Here are steps to be conducted by the Lead Assessor: 

• Display the Consolidated questionnaire tab in the Consolidating Data page. 
• Use the "Details" area to select the questionnaire, Key Area and question number for which the 

response is to be modified. A set of three combo boxes is provided for this purpose. 
• Select the Unbiased answer checkbox and using the combo box below the checkbox, change the 

answer of the selected question.  
• Repeat the above step until all questions to be modified have been updated. 
• Display the Results tab in the Analyzing page. 
• Select the Generate Results button followed by the Extract Findings button, which is used to 

extract findings based on the defined set of thresholds.   
• Review the effects of having made modifications to the questions by viewing relevant information 

in the "Statistics" area and by reviewing the findings displayed in the Findings tab in the 
Analyzing page. 
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PRINTING FEATURES OF XPRIMER 
 
One of XPRIMER’s main strengths is its ability to print useful reports.  The Lead Assessor can make use of 
generic templates to print standard reports and have the flexibility of modifying these templates to generate 
reports to meet their specific needs. 
 
Printing is available on five of XPRIMER’s six main pages by selecting Print report from the pop-up bar 
that appears when the Tools menu pad is selected.  A Report editor window is then displayed along with a 
menu bar with standard editing features (e.g. File – Open, Save, Save as, Close, Edit – Cut, Copy, Paste, 
Select all).  NOTE: It is important not to modify fields that are colored in blue and are between brackets (< >) 
in this window, since they will be replaced by the text to which they correspond at the time of printing.  
Command statements are also found in blue text and represent simple ‘looping’ instructions (e.g. to print all 
‘questions’ within a Key Area, starting with the first one, and ending with the last one). 
 
Alongside the File and Edit items on the Tool menu pad are two additional menu items, Tools and Tags, 
which are described below: 

• The Lead Assessor is free to arrange the order in which fields will appear in the printed report by 
editing the Report editor window as she/he feels.  To insert a field, simply positioning the cursor at 
the desired location in the window and select the field from the list that appears when the Tags 
menu pad is selected. 

• Once the Report Editor window is to the liking of the Lead Assessor, the new template must be 
saved and the report generated.  These two activities are conducted by selecting Build from the 
pop-up bar that appears when the Tools menu pad is selected. The Lead Assessor is then prompted 
for a file name and location in which to save the rich text format (rtf) file. NOTE:  All reports are 
stored as rich text format documents. 

• When printing ‘questions’ and/or ‘observations’ in a report, the Lead Assessor is also given the 
ability of printing either all questions and observations or only those specific ones based on some 
unique characteristics.  These characteristics can be picked by selecting Options from the pop-up 
bar that appears when the Tools menu pad is selected. 

 
Printing of graphs generated by XPRIMER is also very easy.  The Lead Assessor simply has to view the 
graph and select Export JPEG image from the pop-up bar that appears when the Tools menu pad is selected.  
The Lead Assessor is then prompted for a file name and location in which to save the jpeg file. 
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ACTIVITY ONE - IDENTIFICATION  
 
Select the Identification page in order to display the Identification tab.  This tab contains general information 
about the scope of the assessment to be conducted, particularly “where” it is being conducted. 
 
Please enter information in the following fields: 
 

• Organization Name: Enter the name of the Enterprise or Organization where the assessment is 
being conducted. 

 
• Standard Industrial Code (SIC):  Enter the SIC code of the Enterprise or Organization. A two-

digit code designates each major industry group, which is coupled with a second two-digit code 
representing subcategories. 

 
• Number of people affected:  Enter the size of the organizational ‘unit’ being assessed (e.g. an IT 

department may consist of 50 people – managers and practitioners, in an organization that may 
have more that 200 employees). 

 
• Total number of people: Enter the total size of the enterprise or organization. This number must 

be larger than ‘number of people affected. 
 

• Zip/Postal Code: Enter the enterprise’s zip code or postal code. 
 

• Country: Enter the country where the enterprise is being assessed 
 

NOTE An assessment usually consists of capturing observations based on a set of ‘representative 
projects or initiatives’ in an organization.  These representative projects or initiatives are called 
‘entities’ in the XPRIMER application.  The Lead Assessor must enter at least one entity in order to 
proceed with their assessment.  Entities are created using the Add, Edit, and Delete command buttons.  
Each representative project or initiative should be assigned a unique ‘entity’ along with its proper 
name and alias (for confidentiality purposes). 
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ACTIVITY TWO – CUSTOMIZING SURVEY QUESTIONNAIRES  
 
Select the Customizing Survey Questionnaires page to display the Customize Key Areas and Customize 
questions tabs.[Note: Tab headings may vary slightly depending on the model selected for the assessment – 
some models may further qualify Key Areas into ‘Process’ and ‘Risk’]. 
 

• It is highly recommended that the Lead Assessor review all Key Areas and questions for their 
clarity and to make any necessary adjustments using the provided fields.  

 
• A Lead Assessor is free to decide to accept all displayed questions and Key Areas ‘as is’ without 

making any modifications. 
 
• Key Areas can be modified or deselected (i.e. removed) from an assessment. To make 

modifications to the name of a Key Area, simply select the Use modified box associated with the 
Key Area name and then type in a new Key Area name in the Modified Key Area name field. 

 
• Questions of a Key Area can be modified or deleted. The Lead Assessor can make use of the 

Remove question, Restore Question, Update, and Cancel commands along with the Modified 
text box to make modifications to the text displayed under the Original text tab. 

 
• Adding new questions or Key Areas to an assessment is not permitted (i.e. this can only be 

accomplished using the Model Editor). 
 
• It is highly recommended to keep Weights for Key Areas and questions at an Average setting. 
 
• Under the Customize questions tab, the most important field is that of Question tab.  The more 

the text of a question can be worded using the organization’s terminologies (or jargons), the more 
successful the assessment will be in terms of capturing relevant information from participants.  

 
• Not all models will have populated the Finding, Canned Script, and Help tabs with information. 

These tabs will contain information as long as it had been defined when the model was first 
created (using the Model Editor). If these tabs have not been populated, this should not be reason 
for concern. These tabs can be left empty. Alternatively, the Lead Assessor may decide to enter 
information in these tabs as he/she sees fit.  

 
o Text under the Finding tab should display context as to ‘WHY’ the practice statement under 

the ‘Question’ tab is a key practice that should be implemented in the 
entity/project/organization being assessed. If it is a risk statement under review, this tab 
should display context as to the potential ‘consequences’ if the risk were to materialize into 
problem.   

o The Canned Script tab should display questions that may be asked to participants during 
interviews which may trigger a better (and more relevant) response from assessment 
participants.  

o The Help tab should display information to help Respondents interpret the question to which 
they are requested to respond.  

o No modifications can be made to information displayed on the Parameters tab.
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ACTIVITY THREE – SELECTING SURVEY PARTICIPANTS 
 
Select the Selecting Survey Participants page to display the Participant information, and Assign 
participants tabs.  
 

• If you are in a SURVEY mode or SURVEY AND VERIFICATION mode, add in the names of 
each survey respondent on the Participant information tab.  The fields colored in blue are 
mandatory and a unique alias must be assigned to each respondent. Select the Respondent radio 
button and make sure the Default username and Default password radio buttons are also 
selected for each new respondent.  This will represent username and password assignments that 
will be provided electronically via email to each survey Respondent, along with a URL address in 
which to retrieve their questionnaire (more on this topic later – on Activity 4 – Managing Survey 
Questionnaires). A list of all respondents created is organized alphabetically on the right hand area 
called Display.  If respondent information is to be updated, select (highlight) the respondent from 
this list, make the necessary modifications, and then select the Save changes command. If you 
want to clear all the fields on display, select Clear fields from the pop-up bar that appears when 
the Tools menu pad is selected.  To delete a respondent for the list of survey respondents, 
highlight the respondent on the list on the right hand area called ‘Display’ and then select the 
Remove participant command. 

 
• If in a VERIFICATION mode or SURVEY AND VERIFICATION mode, and if there is a group 

of assessors (minimum of 1) assisting you in the verification tasks, you must add in the names of 
each assessor in the Participant information tab.  The fields colored in blue are mandatory and a 
unique alias must be assigned to each assessor. Select the assessor radio button and make sure the 
Default username and Default password radio buttons are also selected for each assessor added.  
This will represent username and password assignments that will be provided electronically via 
email to each assessor in the course of the assessment, along with a URL address in which to 
retrieve their questionnaire (more on this topic later – on Activity 4 – Managing Survey 
Questionnaires). A list of all assessors is organized alphabetically on the right hand area called 
Display.  NOTE: THE LEAD ASSESSOR SHOULD NOT ADD HIS/HER NAME TO THIS 
LIST. 

 
• At any point during an assessment, regardless of which mode, the Lead Assessor can insert new 

survey respondents or assessors as he/she wishes (by repeating the above steps). 
 
• Next, Key Areas must be assigned to each survey respondent and assessor.  To proceed, the Lead 

Assessor must view the Assign participants tab.  For each participant (respondent or assessor) 
place a checkmark on Key Areas you wish to allocate to the highlighted participant.  Depending 
on the model you select, there may be Process Key Areas as well as Risk Key Areas to assign.  
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ACTIVITY FOUR – MANAGE SURVEY QUESTIONNAIRES  
 
Select the Managing Survey Questionnaires page to access the Transmit/Receive center, Review 
respondent questionnaire, and Participant status tabs, which are discussed below. 
 
The Transmit/Receive center tab allows the Lead Assessor to control the transmission of questionnaires to 
survey respondents, the retrieval of questionnaire responses from survey respondents, the transmission of 
assessor questionnaires, and the retrieval of assessor questionnaires (i.e. observations – strengths and 
weaknesses). 
 
From the Review respondent questionnaires tab, the Lead Assessor can review responses provided by 
Respondents.  
 
From the Participant status tab, the Lead Assessor can review the status of questionnaires assigned to either 
Respondents or Assessors.   
 

If you are in a SURVEY mode or SURVEY AND VERIFICATION mode, the following must be 
conducted.  

 
• From the Transmitting Survey Questionnaires tab, questionnaire can be sent to respondents by 

highlighting their alias name on the right hand area (Questionnaires assigned), selecting a time 
limit for the respondent to answer their questionnaire, and then selecting the Send selected 
questionnaire(s) command.  Multiple respondents can be highlighted at the same time and be sent 
questionnaires simultaneously (with the same time limit). 

IMPORTANT: Before sending any questionnaires to survey respondents, you must edit the 
contents of two files, the Outgoing email message and the Read me page, as these will guide 
respondents as to how to proceed when answering their questionnaires.  A generic Outgoing 
message can be accessed and modified by selecting Edit outgoing email from the pop-up bar that 
appears when the Tools menu pad is selected. A generic Read me page can be accessed and 
modified by selecting Edit Read me page content from the pop-up bar that appears when the Tools 
menu pad is selected. Mark-ups are inserted directly over the generic text. It is important not to 
modify fields that are between brackets (< >) in this window, since they will be replaced by the 
text to which they correspond in the e-mail transmitted to respondents.   

CAUTION: If you attempt to resend a questionnaire to a respondent, you will be reminded (via a 
prompt) that you will in fact be retransmitting a BLANK questionnaire to the respondent.  

 
• From the Participant status tab, the Lead Assessor is able to monitor the status of each sent 

questionnaire.  If a participant requires an extension to their questionnaire time limit, this can be 
provided by first selecting the participant name from the list and then selecting the Change due 
date command and entering a new date and time, as prompted.   
 
NOTE: This Participant status tab should be monitored regularly to ensure participants are 
completing their questionnaires and to determine if email reminders are warranted (or friendly 
phone calls!)  

SUGGESTION: If you notice from the Participant Status page that all respondent questionnaires 
have been completed prior to expiration of the time limit (i.e. complete fields are all X’d off), and 
you decide to start your analysis phase sooner, you should first lock participants from re-entering 
their questionnaires.  This is achieved by selecting the participant name and then selecting the 
Lock participant command. Participants who have been locked in this fashion can be unlocked 
the same way.  

• From the Transmitting Survey Questionnaires tab, questionnaires can be retrieved (whether 
completed or partially completed) by selecting Check for new questionnaires from the pop-up 

bar that appears when the Tools menu pad is selected.  Only questionnaires which have been 
modified since the last check for new questionnaires will be retrieved (as this function can be 
repeatedly selected). 
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NOTE: Completed questionnaires received are listed in the window immediately below the 
Questionnaires to include area.  XPRIMER checks the status of transmitted questionnaires every 
minute.  The "√" or "X" displayed on the left of each completed questionnaire determines whether 
the corresponding questionnaire will be used in the analysis.  When an "X" is displayed, the 
corresponding questionnaire will not be used in the analysis. This field can be toggled via double 
clicking the particular respondent alias name on the list.  This feature is provided since the Lead 
Assessor, while reviewing questionnaire responses, may decide that a given questionnaire should 
be removed from the analysis. This situation may occur, when it is determined that a participant 
has not provided significant responses to a large number of questions (for instance by being unable 
to take a stand on the topics addressed in the questionnaire) and nothing much is gained by 
including it in the analysis.   

 
 
• From the Review respondent questionnaires tab, the Lead Assessor can review responses 

provided by Respondents.   

The Review respondent questionnaire tab is divided into five areas: Details, Respondent details, 
Answer given, Comments given, and Questionnaire statistics.  

The “Details” area is used to select the questionnaire, Key Area and question number for which 
the response is to be displayed. A set of three combo boxes is provided for this purpose. The first 
item to specify is the Questionnaire. Then, the Key Area containing the question for which the 
response will be displayed is selected in the second combo box. Finally, the question itself is 
selected with the help of the third combo box.  

The “Respondent details” area is used to select the Respondent whose answers are to be 
reviewed. The combo box on the right of Respondents allows the Lead Assessor to select the 
Respondent for whom responses to the survey questionnaire will be displayed. 

NOTE: Assessors are not included in the pop-up menu since the Review respondent 
questionnaires tab is specifically provided to review information provided by Respondents. By 
default, only received questionnaires are listed.   

After the question has been selected, the text of the question is displayed in the window 
immediately below the “Details” area. One other tab is also available: the Help tab displays 
information to help Respondents interpret the question to which they are requested to respond. The 
Help tab will contain information as long as it had been defined when the model was first created 
(i.e. by the Model Editor) or when the questions were tailored (see ACTIVITY TWO – 
CUSTOMIZING SURVEY QUESTIONNAIRES).   

The “Answer given” area is used to display the response provided by the Respondent for the 
corresponding question. Thirteen choices are available:  

 

 

 

Strongly
Disagree

Strongly
Agree

Somewhat
Disagree

Somewhat
Agree

0 1 2 3 4 5 6 7 8 9

Don’t
Know

Out of
Domain

Not
Applicable
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• 0 – 9 with the following qualifications:  
a. 9 (Strongly Agree) - In all but exceptional cases the condition described by the 

statement or suggested by the question corresponds to the present situation 
b. 5 (Somewhat Agree) - More often than not the condition described by the 

statement or suggested by the question corresponds to the present situation, but 
there are frequent exceptions 

c. 4 (Somewhat Disagree) - More often than not the condition described by the 
statement or suggested by the question does not correspond to the present 
situation, but there are frequent exceptions 

d. 0 (Strongly Disagree) - In all but exceptional cases the condition described by the 
statement or suggested by the question does not correspond to the present 
situation 

• Not Applicable - The condition described by the statement or suggested by the question 
is not applicable to the present situation 

• Unknown – The participant did not have sufficient information to qualify the condition 
described by the statement or suggested by the question with respect to the present 
situation 

• Out of Domain – The participant did not have sufficient expertise to qualify the 
condition described by the statement or suggested by the question with respect to the 
present situation  

The “Comments given” area is used to display comments provided by Respondents in connection 
with the question.   

The “Questionnaire statistics” provides information regarding the questionnaire completed by 
the Respondent. Invalid questions are questions for which either no response has been provided or 
no useful information has been provided in the responses (Out of domain or Not applicable).  

If you are in a VERIFICATION mode or SURVEY AND VERIFICATION mode, the following steps 
must be conducted. 

  
• From the Transmitting Survey Questionnaires tab, a questionnaire can be sent to an assessor by 

highlighting their alias name on the right hand area (Questionnaires assigned), selecting a time 
limit for an assessor to provide their observations, and then selecting the Send selected 
questionnaire(s) command.  Multiple assessors can be highlighted at the same time and be sent 
questionnaires simultaneously (with the same time limit). 

IMPORTANT: Before sending any questionnaires to assessors, you must first edit the contents of 
two files, the Outgoing email message and the Read me page, as these will guide assessors as to 
how to proceed in generating observations (i.e. strengths, weaknesses, and alternatives).  A generic 
Outgoing message can be accessed and modified by selecting Edit outgoing email from the pop-up 
bar that appears when the Tools menu pad is selected. A generic Read me page can be accessed 
and modified by selecting Edit Read me page content from the pop-up bar that appears when the 
Tools menu pad is selected. It is important not to modify fields that are between brackets (< >) in 
this window, since they will be replaced by the text to which they correspond in the e-mail 
transmitted to participants. 

EXTREMELY IMPORTANT: When the recipients are Assessors, and if you are in a SURVEY or 
SURVEY AND VERIFICATION mode the questionnaire in which all completed survey 
questionnaires have been consolidated (otherwise referred to as consolidated questionnaire) is 
used. This situation occurs when a team of Assessors verify the results of a survey compiled after 

participants have completed basic survey questionnaires. The "√" or "X" displayed on the left of 
each completed questionnaire , in the area labeled Questionnaire to include, determines whether 
the corresponding questionnaire will be included as part of the consolidated questionnaire 
submitted to the assessors. 
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• From the Participant status tab, you are able to monitor the status of each sent questionnaire.  If 
an assessor requires an extension to their time limit to generate observations (i.e. strengths, 
weaknesses, and alternatives), this can be provided by first selecting the assessor name, then 
selecting Change due date command and then entering a new date and time, as prompted.   

 
NOTE: This Participant status tab should be monitored regularly to ensure assessors are 
accessing their questionnaires frequently.  The Lead Assessor should normally assign a ‘generous’ 
time limit so as to not unnecessarily get caught making frequent changes to the due dates.  If the 
assessment team finishes early, the Lead Assessor can decide to lock each assessor from further 
accessing and making changes to their questionnaires.  This is achieved by first selecting the 
participant name and then selecting the Lock participant command. Participants who have been 
locked in this fashion can be unlocked the same way.  
 
EXCEPTION:  Unlike the SURVEY mode, the Lead Assessor, if he/she wishes, can resend 
assessor questionnaires at any point in time.  This normally occurs in exceptional circumstances, 
for instance - when changes have occurred in the ‘consolidated questionnaire’ and this 
questionnaire should be redistributed to all assessors (this could have been due to a survey 
respondent questionnaire coming in late, whereby the assessment team had not been previously 
provided with this respondents information).  
 
REAL TIME UPDATES – Observations (i.e. strengths and weakness) generated by the Lead 
Assessor as well as the team of assessors, can be reviewed on the XPRIMER application by the 
Lead Assessor (and by assessors on their client web page) in real time. The update rates for 
information to be provided by both the Lead Assessor and their group of assessors can be viewed 
and modified by selecting the menu bar  Edit and then selecting Preferences.  From experience, 
this setting should be at: Update observations every - 300 seconds 

• Locking a questionnaire is performed automatically when it is transmitted to a participant. After 
the questionnaire has been placed on the server, it is then automatically unlocks and either the 
Respondent or the Assessor to whom it is assigned can access it. 

This locking function is particularly useful when the Lead Assessor is interacting with Assessors. 
For the latter, their questionnaire can be repeatedly transmitted to them as they progress in their 
auditing activities (e.g. new information being received from surveys or reallocation of surveys). 
This is so because Assessors receive this information when they first log on. They therefore need 
to log off, and log back on to have access to this new information. Locking Assessors is one way 
the Lead Assessor has at his or her disposal to force this. After an Assessor has been locked out, 
any action he or she takes will result in a page being displayed on the Assessor's screen indicating 
that he or she needs to log back on. The Assessor will be able to do so after the Lead Assessor will 
have unlocked the corresponding questionnaire.  
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ACTIVITY FIVE – CONSOLIDATING DATA  

The Consolidated questionnaire tab in the Consolidating Data page is used to review consolidated 
responses provided by all Respondents included in the assessment (the Lead Assessor may decide not to 
include the responses received from specific Respondents by changing the " �" displayed on the left of their 
questionnaire to an "X" in the Transmit/Receive center tab of the Managing Survey Questionnaires page).   

• The Consolidated questionnaire tab is divided into two areas: "Details" and "Results".  
 

• The "Details" area is used to select the questionnaire, Key Area and question number for which 
consolidated responses are to be displayed. A set of three combo boxes is provided for this 
purpose. The first item to specify is the Questionnaire. Then, the Key Area containing the question 
for which the response will be displayed is selected in the second combo box. Finally, the question 
itself is selected with the help of the third combo box.  

 
• Immediately below the "Details" area, two windows are used to display information pertaining to 

the selected question.  
 
The Questions tab of the top window, when selected, displays the text of the selected question.  
 
The Consolidated answer tab of the top window, when selected, displays all responses provided by 
all Respondents that have been included by the Lead Assessor in the assessment. Each answer is 
identified by the Respondent's alias in brackets.  
 
The Canned scripts tab of the top window, when selected, displays the canned script defined in the 
Customize questions tab in the Customizing Survey Questionnaires page. Canned scripts are 
useful to define questions to ask participants during an interview.    
 
The Help tab of the top window, when selected, displays help on interpreting the displayed 
question. The Help information is available to both Respondents and Assessors.  
 
Finally, the Notes tab of the top window, when selected, displays notes that are exchanged 
between the Lead Assessor and Assessor(s) having been assigned that question. The Lead 
Assessor, through this tab, can send notes to the Assessors and likewise, Assessors, through a 
similar function provided in the Assessor client web page, can send notes to the Lead Assessor. 
The update rate for Notes to be interchanged between Lead Assessor and their group of assessors 
can be viewed and modified by selecting the menu bar  Edit and then selecting Preferences.  From 
experience, this setting should be at:  Update notes every - 300 seconds. 
 
The Comments tab of the bottom window, when selected, displays comments that may have been 
provided by Respondents in connection with the selected question when they completed the 
survey. Each comment is identified by the Respondent's alias in brackets.  
 
The Suggested answers tab of the bottom window, when selected, displays the answers suggested 
by Assessor(s) who have collected evidence on the subject addressed by the selected question. 
Assessors can only suggest answers; only the Lead Assessor can actually change the answer. The 
update rate for Suggested answers to be interchanged between assessors and the Lead Assessor 
can be viewed and modified by selecting the menu bar  Edit and then selecting Preferences.  From 
experience, this setting should be at:  Update suggested answer every – 60 seconds 
 
Two command buttons, below the bottom window, are provided to navigate between questions 
instead of using the combo boxes in the "Details" area. By default, as the user navigates with these 
buttons and moves from question to question, the question displayed when the Consolidated 
observations tab is selected will be the same as when the Consolidated questionnaire tab was 
selected. This feature can be disabled by resetting the checkbox displayed next to the "Dock with 
observations" pop-up bar that appears when the Tools menu pad is selected.   
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• The "Results" area is provided to display quantitative information about the selected question, 
namely the value associated with all the responses provided by Respondents included in the 
assessment and the confidence level associated with that value.   

 
For a process question, the displayed response value corresponds to the capacity of the process 
component to which the question refers. For instance, for a desirable process, a value of 0.8 
corresponds to a consolidated answer "Agree", which represents a high capacity; for an 
undesirable process, the same 0.8 value would correspond to a consolidated answer of "Disagree" 
and also represent high capacity.   
 
For a risk question, the displayed response value corresponds to the degree of perceived risk with 
respect to the situation that the question describes. For instance, for a desirable situation, a value 
of 0.8 corresponds to a consolidated answer "Disagree", which represents a high degree of 
perceived risk; for an undesirable situation, the same 0.8 value corresponds to a consolidated 
answer "Agree", which also represents a high degree of perceived risk.   
 
The confidence level represents the reliability of the response value, assuming that the 
Respondents are knowledgeable on the subject for which they provided responses and that they 
constitute a representative sample of the initiative/project within the assessed entity. The 
confidence level is essentially an indication of the amount of relevant information collected on the 
selected survey question. A Respondent having answered "Out of domain" or "Not applicable" to 
the question does not provide any useful information and this reduces the confidence one may 
have in the displayed response value.  

 
• Below the ‘Results’ area, three buttons are available.   

 
The Flag question button, when selected, is used to notify Assessor(s) having been assigned that 
question to pay special attention to it. Assessors see a red flag displayed next to that question on 
their client web page. After having generated results and extracted findings, the Lead Assessor can 
flag all questions associated with a finding by selecting the "Flag all findings" pop-up bar that 
appears when the Tools menu pad is selected  
 
The Lock question button, when selected, prevents Assessors from making any more changes to 
that question, such as recording additional evidence on it in the form of observations. If any 
additional survey questionnaires are received from Respondents after the question has been locked 
by the Lead Assessor, they will have no effect on the locked question. However, if the Lead 
Assessor unlocks the question, includes the additional questionnaires received from these 
Respondents and locks the question again, the locked question will now reflect the responses 
provided by these additional Respondents.   
 
A combo box is displayed under the "Unbiased answer" checkbox. When this checkbox is 
checked, the Lead Assessor can change the answer to the selected question based on the evidence 
provided by Assessors and on their suggested answers.  

The Consolidated observations tab in the Consolidating Data page is used to review consolidated 
observations generated by Assessors. Observations consist of additional information substantiating or 
challenging responses obtained in a survey.   

• The Consolidated observations tab is divided into six areas: "Details", "Navigation", "Observation 
list", "Observation details", Corroborating sources", and "Observation text".  

 
• The "Details" area is used to select the questionnaire, Key Area and question number for which 

the consolidated observations are to be displayed. A set of three combo boxes is provided for this 
purpose. The first item to specify is the Questionnaire. Then, the Key Area containing the question 
for which the observation will be displayed is selected in the second combo box. Finally, the 
question itself for which observations are to be displayed is selected with the help of the third 
combo box.  
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• The "Navigation" area is used to navigate between questions and to filter displayed observations.  
Two combo boxes are provided to allow the Lead Assessor to filter observations to be displayed 
by ‘entity’ and/or by ‘assessor’.  Two command buttons are provided to navigate between 
questions instead of using the combo boxes in the "Details" area. By default, as the user navigates 
with these buttons and moves from question to question, the question displayed when the 
Consolidated questionnaire tab is selected will be the same as when the Consolidated observations 
tab was selected. This feature can be disabled by resetting the checkbox displayed next to the 
"Dock with observations" pop-up bar that appears when the Tools menu pad is selected.   

 
• The "Observation list" area is used to display the headers of observations generated by Assessors 

for the selected question. By clicking on an observation to highlight it, the observation details are 
displayed in the "Observation details" area. Each observation header is preceded by a doublet (e.g. 
[1.1], [1.2], [2.1]). The first number of the doublet indicates the observation number and the 
second number indicates the version of the observation. Therefore, observation [1.2] is more 
recent than observation [1.1]. An observation can also be preceded by a green arrow. This 
indicates that this observation will be transmitted to Assessors when the Lead Assessor will 
retransmit them their questionnaire. In the preceding example, observation [1.2] is preceded by a 
green arrow since it is an update of observation [1.1]. Observations that have been updated in this 
fashion are nevertheless retained and displayed to the Lead Assessor in order to maintain a 
treaceability of observations generated during an assessment. The Lead Assessor can delete them 
by selecting the Delete button if he or she considers that these are obsolete and will no longer be 
of any use. Before deleting them, however, it is recommended to save a copy of the assessment 
file in order to be able to retrieve them should the need arise.   

 
• To the right of the “Observation list” area four buttons are available.   

 
The Flag button, when selected on a highlighted observation, is used to notify Assessor(s) having 
been assigned that observation to pay special attention to it. Assessors see a red flag displayed 
next to that observation on their client web page.   

 
The Lock button, when selected on a highlighted observation, prevents Assessors from making 
any more changes to that observation.  
 
The Delete and Undelete observation buttons, when selected on a highlighted observation, allows 
the Lead Assessor to delete observations or have them undeleted (if an observation had been 
marked for deletion by one of the assessors). 

 
• The "Observation details" area is used to display the detail of a selected observation or to enter a 

new observation. Five fields are provided to characterize an observation: Status (Corroborated or 
Not Corroborated), Response (for a process: Strength, Equivalence or Weakness; for a risk: 
Desirable, Neutral or Undesirable), Original Source (Interview, Document, Questionnaire or 
Validation), Entity, and Specify (details of the Original Source).   

 
• To enter a new observation when no observation is listed in the "List of observations" area, the 

Lead Assessor simply starts assigning values to the aforementioned fields with their associated 
combo boxes. The text of the observation is then entered in free text in the "Observation text" area 
and the Add observation command button is selected.   

 
To enter a new observation when an observation is already highlighted and the "Observation 
details" displays the details of the observation, the Lead Assessor must first select the "Clear 
Fields" command button or pop-up bar under the Tools menu pad to reset the observations details 
to blank values. Values are then assigned to the fields with the combo boxes, the observation text 
is entered and the Add command button is selected.   
 

• The Lead Assessor can also modify the details of an existing observation. To do so, the Lead 
Assessor must first select the observation in the "Observation list" area, assign new values to one 
or more of the observation fields with their associated combo boxes and modify the text of the 
observation as needed. The modified observation is saved when the Save command button is 

selected. Doing so will result in the Assessor's alias being replaced with the Lead Assessor's alias. 
If on the other hand, an Assessor modifies on his or her client web page an observation generated 
by the Lead Assessor, the Lead Assessor's observation will remain unchanged and a new 
observation with the Assessor's alias will have been generated.  

 
Note that the Lead Assessor and Assessors can simultaneously generate observations for the same 
question. However, if the Lead Assessor transmits a consolidated questionnaire to Assessors and 
subsequently modifies some of the observations it contained or generates new ones, Assessors will 
have access to this new information only when the Lead Assessor will have retransmitted them 
their consolidated questionnaire. No information will ever be lost.  

 
• The flexibility that XPRIMER offers is at the cost of having the Lead Assessor deal with duplicate 

information. However, this situation is significantly better than having the Lead Assessor deal 
with lost information without his or her knowledge.  

 
• The "Corroborating sources" area is used to corroborate observations. Typically, when a new 

observation is entered, it is not corroborated. Corroboration occurs when several independent 
sources have confirmed the validity of the observation. Several individuals making the same 
statement during a specific interview is usually not sufficient to corroborate an observation 
because these individuals are liable to influence each other. This is particularly true if they are at 
different levels of hierarchy. In this case, the individual being the highest in the hierarchy is likely 
to somehow impede the free flow of information on the part of individuals lower in the hierarchy.   

 
Corroboration is normally achieved by the same information recorded in two separate 
questionnaires, in two separate interviews, in two separate documents (for instance, one document 
stating that something must be done and a second document providing evidence that it has 
effectively been done) or in two separate validation sessions where participants concur with the 
observation presented to them.  

 
Nevertheless, corroboration remains by and large a question of judgment on the part of the Lead 
Assessor and the Assessors. Generally speaking, confidence increases with the number of 
corroborating sources and their variety.  

 
• In the "Corroborating sources" area, five sources are presented (Questionnaire, Interview, 

Validation, Direct Artifact and Indirect Artifact). Next to each, a text box is available to enter 
specifics about one or more sources of each type.    

 
The Lead Assessor can modify the corroborating sources of an existing observation and doing so 
will result in the Assessor's alias being replaced with the Lead Assessor's alias if that observation 
had initially been entered by an Assessor.  

 
• The "Observation text" area is used to enter the text of the observation. This is essentially free text 

providing evidence for the selected question. In order to display the text of an existing 
observation, that observation must first be selected in the "Observation list" area.   

 
The Lead Assessor can modify the text of an existing observation and doing so will result in the 
Assessor's alias being replaced with the Lead Assessor's alias if that observation had initially been 
entered by an Assessor. 

 
Other functionality is accessible from the pop-up bar that appears when the Tools menu pad is 
selected. These are 

a. Promote observation - Promotes an old observation to current (i.e. moves it to the top). 
b. Refresh current - Refreshes the observation currently displayed (i.e. to see changes 

made by assessors immediately). 
c. Refresh all - Refreshes all observations (i.e. to see changes made by assessors 

immediately) 



ACTIVITY SIX – CONSOLIDATING DATA  • How do I copy an observation recorded under a given practice to another practice? 
 

Sometimes you realize after the fact that an observation you have entered under a given practice 
really belongs to another. Instead of retyping the practice and the corroborating sources, you can 
easily copy and paste or cut and paste the observation to another practice by executing the 
following steps. 

 

  
The Analyzing page is used in XPRIMER to analyze the information collected during an assessment, to 
display the risk and action readiness , to view the risk profile characterizing the assessed entity and to extract 
both risks to which the entity is exposed and the actions it should take for preventing these risks from 
materializing.  
 

a. Select the Observation you want to copy from the Observations list area. NOTE:  The applicability of each display will rely on the type of model selected for the assessment, as some 
displays can not be generated with certain model types. b. Select Copy observation or Cut observation from the pop-up bar that appears when 

the Tools menu pad is selected.  
c. Using the combo boxes in the details area, select the Key Area and question where you 

want to copy the observation. 
VERY IMPORTANT: For simplicities sake, we will describe the analysis in an assessment where a practices 
questionnaire and risk questionnaire have been built into the selected model.  If the selected model only had 
one questionnaire, functionality will depend on whether a risk questionnaire was distributed in the assessment 
or a practices questionnaire was distributed. 

d. Select the Paste observation from the pop-up bar that appears when the Tools menu 
pad is selected. 

e. If you had initially selected the Cut observation, you will notice that the observation 
has been removed from the Observation list of the initial question.  

 
All survey questionnaires completed by Respondents and/or observations generated by Assessors in their 
consolidated questionnaires need not have been received in order to start an analysis. As long as some 
information is available, an analysis can be initiated and as more information is collected, it is simply added 
to the existing information. Survey responses originating from Respondents are automatically consolidated by 
XPRIMER as they are received, as long as a checkmark is displayed on the left of each received questionnaire 
listed in the Transmit/Receive center tab in the Managing Survey Questionnaire page. Analysis can be 
performed periodically with new sets of data in order to take a snapshot of the entity's risk profile at periodic 
intervals, or it can be performed continuously, by monitoring the entity's risk profile as more information 
becomes available.  
 
The Analyzing page contains four tabs:  Results, Findings, Graphics, and 3D Graphics. 
 
The Results tab in the Analyzing page is used to review the risk data compiled after a survey or an audit has 
been completed and to set up thresholds that will allow extraction of relevant information. The Results tab is 
divided into two areas: "Statistics" and "Thresholds". In addition, under the Statistics areas, up to four 
additional tabs are provided to sequence through four sets of results. 
   

• Three command buttons are provided in the bottom right of the Results tab: the Generate Results 
button, which is used to generate results after survey questionnaires have been received; the 
Extract Findings button, which is used to extract findings based on the defined set of thresholds; 
and the Default Thresholds, which is used to revert to XPRIMER default thresholds.  
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• The "Statistics" area summarizes the results of the assessment by displaying: the Global risk value 
characterizing the assessed entity. This value represents the likelihood that the entity will 
experience problems, based on the modulation of the risk perception level by the readiness of the 
entity to take action in response to the occurrence of undesirable events. An analysis conducted 
over a large number of assessments combined with a follow-up of the assessed entities has shown 
that an entity cannot sustain a likelihood of experiencing problems higher than 40% for any 
significant duration relative to the planned or current activities. This value of 40% can be 
explained by the fact that a value of 50% corresponds to a random occurrence of problems, and it 
would be wishful thinking to expect conclusive results over a significant period of time for an 
entity operating under such conditions. The 40% value is the limit which indicates that there is 
some control to prevent problems from occurring.  

 
Action readiness (depending on the model used in the assessment, this may or may not display a 
value) corresponds to the mechanisms that are in place to prevent problems from occurring. It is 
effectively equivalent to the process maturity expressed in terms of implementation percentage of 
best practices (actions) pertaining to the domain of interest addressed in the model.  
 
The Perceived risk (depending on the model used in the assessment, this may or may not display 
a value) level has two meanings, depending on whether a biased or an unbiased assessment has 
been performed. A biased assessment only relies on a survey. An unbiased assessment relies either 
on an audit (verification) or on survey followed by an audit (verification) during which collected 
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information has been verified by unbiased Assessors (it also possible that in the course of a biased 
assessment, only part of the information is verified by unbiased Assessors, which makes the 
assessment more objective than a purely biased assessment but also more subjective than a purely 
unbiased assessment).   
 
If a biased assessment has been performed, Perceived risk corresponds to the capacity of personnel 
to anticipate potential problems and to initiate whatever action is required to prevent their 
occurrence. Global risk will decrease as Perceived risk increases for a given value of Action 
readiness. In this context, Perceived risk depends to some extent on personnel experience and 
know-how. It also depends on Action readiness in the sense that an entity exhibiting a high 
capacity of taking action is less likely to have to rely on its personnel’s ability to anticipate 
problems than an organization exhibiting a lower capacity, since the former is more likely to have 
integrated mechanisms required to generate an early warning of upcoming problems. In fact, a 
high capacity of taking action may compensate for the lack of experienced personnel. In other 
words, an entity may choose to hire very talented and experienced people, in other words heroes 
(more expensive), and rely on them to carry out the tasks undertaken by the entity to which they 
belong, with the help of a support infrastructure reduced to its minimum (less expensive), or it can 
choose to develop an extensive support infrastructure (more expensive) with a smaller number of 
highly experienced people (less expensive).   
 
If, on the other hand, an unbiased assessment has been performed, Perceived risk corresponds to 
the density of undesirable events to which an entity is exposed, as identified by objective assessors 
who have substantiated evidence that these events indeed lie in waiting. Such a situation is likely 
the result of poor understanding of the risks, on the part of its personnel, to which the entity is 
exposed or of a low capacity of taking action should these risks materialize.    
 
A Suggested Rating (depending on the model used in the assessment, this may or may not display 
a value) is also provided as part of the assessment results overview.   
 
The number of finding pairs (depending on the model used in the assessment, this may or may 
not display a value), i.e. risk-action, extracted with the selected thresholds is displayed under 
Findings Summary. Since a given risk finding may be associated with several action findings and 
conversely, an action finding may be associated with several risk findings, the number of unique 
action and risk findings is displayed immediately below the number of finding pairs.  

 
• Immediately below the "Statistics" area, more detailed assessment results are provided namely, 

Probable risk consolidated over key action areas, Action readiness, Probable risk consolidated 
over key risk areas and Perceived risk. Percentage values are displayed next to either key action 
areas or key risk areas. (Depending on the model used in the assessment, some tabs may not get 
displayed). 

 
Probable risk consolidated over key risk areas indicates the likelihood that problems will be 
experienced in each of the listed key risk areas. Probable risk consolidated over key action 
areas indicates the likelihood that problems experienced in key risk areas will be due to 
deficiencies in each of the listed key action areas. Action readiness indicates the degree to which 
key action area mechanisms are in place to prevent problems from occurring. Finally, Perceived 
risk indicates either the capacity of personnel to anticipate problems in key risk areas if a biased 
assessment had been performed, or the density of undesirable events to which an entity is exposed 
if an unbiased assessment had been performed.   

 
• The 'Thresholds' area provides the user with the means of filtering the risk and action findings 

resulting from the assessment. These findings are essentially the main issues that need to be dealt 
with in order to increase the chances of success in the domain addressed by the model used in the 
assessment. Thresholds provide a way of prioritizing these issues in order to increase the chances 
of success.   

 
Thresholds are expressed in percentages. An action finding will be extracted and displayed under 
the Findings tab as long as the level of readiness associated with this action is lower than or equal 

to the Action Readiness Low threshold value, and the confidence one has in this level of readiness, 
based on the survey or audit results, is higher than or equal to the Action Readiness Confidence 
threshold level. Because actions and risks always come in pairs, risk must also be considered when 
an action is extracted. In other words, the aforementioned action will be extracted as long as the 
preceding conditions are satisfied and as long as a risk which can be mitigated by that action has 
been perceived at a level lower than or equal to the Perceived risk Low threshold value (but at a 
level higher than or equal to the Perceived risk Minimum processed and the Perceived risk 
Minimum displayed threshold values (whichever is the highest)), or at a level higher than the 
Perceived risk High threshold value, and the confidence one has in this risk perception, based on 
the survey or audit results, is higher than or equal to the Perceived risk Confidence threshold 
level.   

Example: 
Action Readiness 
Low value = 40 % 
Confidence level = 70 % 
 
Perceived Risk 
High value = 85 % 
Low value = 20 % 
Minimum displayed = 10 % 
Minimum processed = 0 % 
Confidence level = 70 % 
 

This may sound complicated but it is actually quite simple. For instance, in a biased assessment 
and with the thresholds as shown above, one essentially tells to display risks that are poorly 
perceived (a perception lower than 20%) and for which actions are unlikely to be available 
(readiness lower than 40%) as well as risks that are well perceived (higher than 85%) but for 
which actions may also not be available (readiness lower than 20%). The first condition could lead 
to a surprise effect (no one expected that there could be a problem there!) whereas the second 
condition could still lead to deterioration because, even though problems were anticipated, 
appropriate action may not be available to mitigate their impact. Confidence threshold levels are 
used to filter out noise.  
 
The Perceived risk Minimum displayed threshold is used to filter out risks for which the 
perception level is so low (typically lower than 10%) that they are unlikely to occur, even though 
these risks are taken into account in the risk calculations. In the course of a biased assessment of 
an entity in which mostly routine tasks are performed, the Perceived risk Minimum processed 
threshold is used to tell XPRIMER not to take into account risks for which the perception level is 
low (typically lower than a threshold set at a value between 1% and 10%) in the calculation 
because in such routine tasks, it is likely that these risks are truly not an issue. However, when the 
results of a biased assessment have been audited by a team of unbiased Assessors, the Perceived 
risk Minimum processed and the Perceived risk Minimum displayed thresholds should be 
reinitialized to 0%.  

 
The graphs available under the Graphics tab can also be used to help select appropriate thresholds 
and to determine where the assessed entity stands in terms of risk.  

 
The Findings tab in the Analyzing page is used to review the risk and/or action findings that have been 
extracted with the defined thresholds when the Extract Findings command button is selected. The Findings 
tab is divided into two "Details" areas, one pertaining to risks and one pertaining to actions. Under each area, 
additional information is provided on the displayed risk or action.  
 

• Each of the two "Details" areas allows the selection of the questionnaire type (either risk or 
process - process being equivalent to action with the models), Key Area and Question number 
with the help of combo boxes. Selecting a specific question in a given Key Area from either a risk 
or a process questionnaire results in the display of perceived risk or action readiness, respectively, 
for that question, along with the confidence one may have in the displayed result.   
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Both "Details" areas are normally displayed next to each other. Each is separated by a vertical bar 
at the top of which two arrows are displayed. Clicking on the right-pointing arrow makes the left 
"Details" area occupy the entire screen. Clicking on the left-pointing arrow reverts back to a split 
screen. Likewise, when a split screen is displayed, clicking on the left-pointing arrow makes the 
right "Details" area occupy the entire screen.   

 
• If the left "Details" area is set up to display Process findings, the right "Details" area displays 

Risks findings that correspond to risks liable to be mitigated if the deficiencies observed with the 
displayed Process finding are corrected in the assessed entity. Likewise, if the left "Details" area is 
set up to display Risk findings, the right "Details" area displays Process findings that, if improved 
in the assessed entity, would contribute to reducing the displayed Risk finding.   

 
• The finding corresponding to the selected question number is displayed in a window immediately 

below. This window has three tabs: Finding text, Comments and Notes. The finding is displayed 
when the Finding text tab is selected. Selecting the Notes tab results in a display of a scratchpad to 
enter information that would help tailor the displayed finding. Consolidated comments generated 
by Respondents are displayed when the Comments tab is selected.  

 
• Actions that need to be taken e.g. process finding deficiencies that need to be corrected in order to 

address the corresponding risks facing the assessed entity can now be edited in light of the 
comments and observations entered by Respondents and Assessors, respectively.  This editing can 
be done directly in the XPRIMER application or the findings can be printed in an ASCII file, 
which can subsequently be edited with a word processing application.   

 
• When a displayed risk (or process) finding is modified directly in the XPRIMER application, a 

new association is defined that uniquely pairs this modified risk (or process) finding with the 
displayed process (or risk) finding. When generic findings are modified as part of performing an 
assessment, the number of unique findings can easily grow to several thousands. On the other 
hand, modifying findings in the XPRIMER application allows you to generate assessment files 
tailored to specific types of entities, which can greatly improve your efficiency and your capability 
of performing accurate and representative assessments.  

 
 

The Graphics tab in the Analyzing page is used to review the risk data compiled in the form of graphics.   
Up to eight graphics are available (depending on the model used in the assessment, some graphs may not be 
generated)  

 
• Probable risk/action displays on the y-axis, on a scale of 0.0 to 1.0, the likelihood that problems 

will be experienced as a result of deficiencies in each of the key action areas listed on the x-axis.  
  
• Relative probable risk/action displays on the y-axis, on a scale of 0.0 to 1.0, the likelihood that 

problems will be experienced in the short term as a result of deficiencies in each of the key action 
areas listed on the x-axis. Relative probable risk takes into account the relative importance of key 
action areas by evaluating the complexity of interactions between the actions making up these Key 
Areas and the risks that these actions can mitigate. The higher this complexity, the longer it will 
take to correct deficiencies observed in these key actions areas.   
 

• Probable risk/risk displays on the y-axis, on a scale of 0.0 to 1.0, the likelihood that problems will 
be experienced in each of the key risk areas listed on the x-axis.  
 

• Relative probable risk/risk displays on the y-axis, on a scale of 0.0 to 1.0, the likelihood that 
problems will be experienced in the short term in each of the key risk areas listed on the x-axis. 
Relative probable risk takes into account the relative importance of key risk areas by evaluating 
the complexity of interactions between these risks and the actions available to prevent them from 
materializing. The higher this complexity, the longer it will take to resolve them and the higher the 
probability that problems will be encountered in the short term.  
 

• Perceived risk displays on the y-axis, on a scale of 0.0 to 1.0, the capacity of personnel to 
anticipate problems in each of the key risk areas listed on the x-axis, if a biased assessment had 
been performed. If an unbiased assessment had been performed, that is the survey results have 
been verified and modified as appropriate by unbiased Assessors, Perceived risk displays on the y-
axis the density of undesirable events to which the assessed entity is exposed in each of the key 
risk areas listed on the x-axis .   
 

• Action readiness displays on the y-axis, on a scale of 0.0 to 1.0, the degree to which mechanisms 
are in place in each of the key action areas listed on the x-axis, in order to prevent problems from 
occurring.  

• Confidence/risk displays on the y-axis, on a scale of 0.0 to 1.0, the level of confidence one may 
have in the values displayed in the Probable risk/risk and Relative probable risk/risk graphics, for 
each of the key risk areas listed on the x-axis.  
 

• Confidence/action displays on the y-axis, on a scale of 0.0 to 1.0, the level of confidence one may 
have in the values displayed in the Probable risk/action and Relative probable risk/action graphics, 
for each of the key action areas listed on the x-axis.  
 

Double-clicking one of the graphics in the Graphics page makes it appear in a full screen. Clicking the 
command button Back to Menu returns to the Graphics page.  

 
The 3D Graphics tab in the Analyzing page is used to review the risk profile of the assessed entity in the 
form of three-dimensional graphics (Note: This tab is only available the model being addressed had both risk 
and action questionnaires) 
 

• Four graphics are available and provide different views of the risk profile. The Risk view plots the 
key risk areas on the x-axis, the key action areas on the y-axis and the likelihood of experiencing 
problems in key risk areas as a result of deficiencies in key action areas on the z-axis. The Action 
view plots the key action areas on the x-axis, the key risk areas on the y-axis and the likelihood of 
experiencing problems in key risk areas as a result of deficiencies in key action areas on the z-axis. 
The General view rotates the x-y plane to provide an equidistant perspective of the key risk areas 
and the key action areas. Finally, the Top view provides a view of the x-y plane in which the 
likelihood of experiencing problems in key risk areas as a result of deficiencies in key action areas 
is solely determined by the color of each intersection of a key risk area and a key action area. Blue 
indicates a low likelihood whereas red indicates a high likelihood.  

 
With experience, the risk profile can be very informative, being somewhat analogous to what a 
Computerized Axial Tomography (CAT)-scan is for a brain surgeon.  


